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1. GENERAL 

1.1. Package Contents 
The AEI Tag Programming Software is shipped with the following items: 

• AEI Tag Programming Software User Manual 
• AEI Tag Programming Software Installation CD-ROM 
• DYMO LabelWriter 300 Printer 
• DYMO LabelWriter Address Labels #30252 (two rolls of 350 labels each) 

The AEI Tag programming Software is designed to work with the Amtech AP4110 Tag 
Programmer.  The AP4100 Tag Programmer is not included with this package. 

1.2. System Requirements 
The AEI Tag Programming Software is a 32-bit Windows program that will run on any computer 
running Windows 95, 98, 2000, NT 4.0, ME, or XP.  It will not run under Windows 3.1. 

To program tags you must have: 

• An AP4110 Tag Programmer 
• One free communication (serial) port to interface to the tag programmer 
• One free USB connection or a second communication (serial) port to interface to the DYMO 

LabelWriter 300 printer (a parallel port (LPT) adapter is available for an additional charge) 

If you plan to verify tags with a portable AEI RF tag reader you will need the following: 

• AI2000 Portable AEI Reader 
• A second or third (if you used one of the communication ports for the DYMO LabelWriter 

300 printer) communication (serial) port to interface to the portable reader 

You computer should have a minimum of 32 MB of RAM and at least 4 MB of free disk space. 

2. INSTALLATION 
There are two items that must be installed by the user.  The first item is the AEI Tag Programming 
Software, and the second item is the DYMO LabelWriter 300 printer.  Either item can be installed 
first.  The following describes the installations. 

2.1. Installing the AEI Tag Programming Software 
The AEI Tag Programming Software comes on a CD-ROM.  To install the program, insert the CD-
ROM into the CD-ROM drive.  The installation program should automatically start.  If it does not 
start, click the Start and then the Run buttons.  In the Open box, type d:autorun.exe if your CD-ROM 
is the D drive on your computer.  If it is not the D drive, type the appropriate drive letter followed by a 
colon and then autorun.exe (ex. e:autorun.exe, f:autorun.exe, etc.).  The dialog in Figure 1 will then 
appear. 
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Figure 1 - Installation Dialog 

Click the Install AEI Tag Programming Software Program button to install the program and follow 
the instructions.  During the installation process you will be asked for a serial number.  The serial 
number can be found on the first page of the AEI Tag Programming Software User Manual. 

When the AEI Tag Programming Software Program is installed, it is loaded into the AEI Tag 
Programming folder by default. 

To install an icon on the computer desktop: 

• click the Start button 
• place the mouse pointer on Programs 
• place the mouse pointer on AEI Tag Programming (should be at the bottom of the list) and 

click the right mouse button 
• place the mouse pointer on Send To 
• click on Desktop 

2.2. Installing the DYMO LabelWriter 300 Printer 
The DYMO LabelWriter 300 Printer comes with both a USB and a serial port cable.  An optional 
parallel port adapter (LPT) is also available. 

A Windows Quick Start installation guide is included with the printer, which shows you how to 
connect the printer to your computer and install the printer driver. 

2.3. Starting the Program 
Prior to running the AEI Tag Programming Software for the first time, connect the AP4110 Tag 
Programmer to one of the computer’s communication (serial) ports and turn the tag programmer 
on.  The first time you run the AEI Tag Programming Software it will search all the communication 
ports (1 thru 4 only) looking for the tag programmer. 
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Figure 2 - Main Programming Display 

To start the program, click the computer’s Start button and then click on the AEI Tag Programming 
program. 

After starting the program, the main programming display appears (see Figure 2). 

Every time you start the AEI Tag Programming Software the program will check to see if the tag 
programmer is connected and turned on.  It assumes the programmer is still connected to the 
same communication port it was connected to during the last tag programming session.  If the tag 
programmer is not found, the program will continue to check the same communication port every 
second looking for the tag programmer.  The program will not search the other communication 
ports unless the user requests a search for the tag programmer.  The user can request this 
search by clicking the Programmer menu button and then the Search for Programmer menu item. 
 
Prior to programming tags you must set up the label printer in the AEI Tag Programming Software 
program.  To set up the label printer, click the File menu button and the Label Printer Setup menu 
item.  The dialog in Figure 3 will appear. 
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Figure 3 - Printer Setup 

The DYMO LabelWriter 300 Printer must first be selected by clicking the Printer button (right 
bottom corner) in the Printer Setup dialog.  The dialog in Figure 4 will then appear.  The DYMO 
LabelWriter 300 should be selected as shown in Figure 4.  Once the OK button is clicked, the new 
Printer Setup dialog in Figure 5 will appear. 

As shown in Figure 5, the paper size should be set to 30252 Address and the orientation to 
Landscape in order for the labels to print properly. 

 
Figure 4 - Printer Selection 
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Figure 5 - Page Setup 

The program should now be ready to program AEI tags. 

3. BRIEF OVERVIEW 
The AEI Tag Programming Software was designed to run under Windows, interface to an AP4110 
Tag Programmer (not included), print to a DYMO LabelWriter 300 Printer (included) and optionally 
interface to an AI2000 SmartScan Portable AEI Reader (not included). 

The AEI Tag Programming Software for Windows program was developed to help solve two main 
issues.  The existing tag programming software developed by Amtech and included with each 
AP4110 Tag Programmer is a DOS program.  DOS programs will not run under new Windows 
operating systems such as Windows XP. 

The second issue concerns tag quality.  Tag quality can be broken down into two main concerns.  
The first concern is the accuracy of the data encoded in to the tag.  The AEI Tag Programming 
Software has a number of features that help reduce errors in encoding (programming) data into a 
tag.  The following describes some of these features: 

1. The program makes a number of reasonability checks on the data being entered into the 
tag.  For example, if 5 axles is entered, the program would give a warning that this is an 
unusual entry for this field. 

2. The program contains a subset of UMLER that allows it to check the data being 
programmed into the tag against the vehicle’s UMLER data and warns if there are 
differences.  Because the program’s UMLER database must be periodically updated via a 
CD-ROM, the program may not, however, have the most up-to-date UMLER data. 

3. The program prints all programmed data fields on the tag’s label.  This allows the end user 
of the tag to check all of the tag’s data fields prior to placing the tag on a vehicle. 
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4. The program prints on the tag’s label the name of the organization that programmed the 
tag.  This makes the organization that programmed the tag accountable for errors. 

The second tag quality issue involves the readability of programmed tags by a wayside RF reader.  In 
the early days of programming of AEI tags, it was assumed that any tag able to be programmed 
successfully could also be read by a wayside RF reader.  In the last few years it has been discovered 
that this is not necessarily true.  It has become apparent that RF checking tags after they are 
programmed is an important safeguard against unreadable tags being placed on rail vehicles. 

To facilitate RF checking of programmed tags, the AEI Tag Programming Software can be 
interfaced to an AI2000 SmartScan Portable AEI Reader.  One of the options of the software 
requires a tag to be read by the portable reader after being programmed and prior to printing of 
the tag label.  If the tag is successfully read, the label indicates that an RF reader successfully read 
the tag.  If this option is not set or the tag is not successfully read, the label will indicate the tag was 
not RF checked (see Paragraph 6.8.1). 

Another function of AEI Tag Programming Software is to help certify a used tag for re-use.  The tag 
certification function generates unique data to encode into a tag, programs the tag with the data, 
and then requires the tag to be read by a portable RF reader.  If the portable reader successfully 
reads the tag, a special Certified for Reuse label is created (see Paragraph 6.8.2).  It should be 
noted that range and leak tests should also be conducted on tags being certified for reuse. 

The certification function requires that an AI2000 SmartScan Portable AEI reader be interfaced to 
the AEI Tag Programming Software program.  Tags cannot be certified for reuse without being 
correctly read. 

4. SETUP AND OPTION PARAMETERS 
There are a number of setup and option parameters that should be reviewed prior to programming 
tags. 

4.1. Setup Parameters 
The setup parameters can be accessed by clicking on the Setup menu at the top of the screen.  The 
following describes the setup parameters: 

4.1.1. Assign Log File Name Menu Item 
The program maintains a record of all tags programmed in a text comma delimited file that is 
located, by default, in the same folder as the program.  The default name for this file is “tag log.txt”.  
This function allows the name of the log file to be changed (see Paragraph 10). 

4.1.2. Certification Vehicle Initial Field Menu Item 
The certification function automatically generates vehicle data to be programmed into a tag.  The 
default vehicle initials are “XXXX”.  This function allows the vehicle initials to be changed to any other 
four alpha characters (see Paragraph 6.4). 

4.1.3. Programmed By Field Entry Menu Item 
The tag labels has a field that contains information about who programmed the tag.  This field by 
default contains the text “Unknown”.  This function allows data for this field to be entered (see 
Paragraph 6.8.1). 
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4.1.4. Set Background Color Menu Item 
This function allows the background color of the Main Programming Display to be changed from the 
default color, which is gold. 

4.2. Options Parameters 
The options parameters can be accessed by clicking on the Options menu at the top of the screen. 
The status of these parameters can be seen in the status bar just below the menu bar (see Figure 
6). The following describes the options parameters: 

 

 
Figure 6 - Option Status 

4.2.1. Automatic RF Check Menu Item 
When this item is checked, the program will automatically ask the user to read the tag just 
programmed with a portable reader.  The default value of this parameter is “off”. 

4.2.2. Automatic UMLER Check Menu Item 
When this item is checked, the program will automatically check the data to be programmed into 
the tag against any data in UMLER for the vehicle.  If the program finds the vehicle in UMLER and 
finds a disagreement, it will issue a warning and show the fields that disagree.  By default the 
program automatically checks UMLER. 

4.2.3. Label Printing On Menu Item 
When this item is checked, tag labels are printed when a tag is programmed.  By default, label 
printing is turned on. 

If you place the mouse pointer on any empty area of the screen and click the right mouse, this menu 
item will also appear in a pop-up menu. 

4.2.4. Log File On Menu Item 
When this item is checked, a record is created in the log file each time a tag is programmed.  By 
default the log file is turned on. 

If you place the mouse pointer on any empty area of the screen and click the right mouse, this menu 
item will also appear in a pop-up menu. 

4.2.5. Length In Feet-Inches Menu Item 
Vehicle length fields can be entered in either feet and inches or decimeters.  When this item is 
checked, the program assumes all entries are in feet and inches.  By default feet and inches is 
selected. 
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If you place the mouse pointer on any empty area of the screen and click the right mouse, this menu 
item will also appear in a pop-up menu. 

5. PROGRAMMER 
To program tags, the AEI Tag Programming Software must be connected to the Amtech AP4110 
Tag programmer.  This connection is made via a serial cable from the AP4110 Tag Programmer to 
a communication (serial) port on the computer running the AEI Tag Programming Software. 

Included with the AP4110 Tag Programmer is a null modem that must be attached at one end of 
the serial cable.  These null modems (DB9 Female/ DB9 Male Null Model Adapter Part # 26-152) 
can be purchased at the local RadioShack. 

To communicate with the AP4110 Programmer, the tag programming software must know which 
communication port the tag programmer is connected to.  The first time the AEI Tag Programming 
Software runs it will automatically search all communication ports (1 thru 4 only) for the tag 
programmer.  The tag programmer must be connected and powered on for the program to find it. 

The AEI Tag Programming Software has a number of tools associated with the tag programmer.  
The following describes these tools, which can be accessed by clicking on the Programmer menu in 
the menu bar. 

5.1. Programmer Model and Version Menu Item 
Clicking on the Programmer Model and Version menu item will cause the dialog in Figure 7 to 
appear.  This dialog shows the communication port the programmer is connected to, the model and 
version number of the tag programmer, and the last error message (if any) received from the 
programmer. 

 
Figure 7 - Programmer Parameters 

5.2. Search For Programmer Menu Item 
Clicking on the Search For Programmer menu item will cause the program to search all 
communication ports (1 thru 4 only) for the tag programmer.  The tag programmer must be 
connected and powered on for the program to find it.  Whether or not the tag programmer is 
found, the dialog in Figure 8 will appear.  This dialog shows the status of each of the four 
communication ports.  If a communication port is shown as not active, it can either mean the port 
does not exist on the computer or it is currently being used by another application. 
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Figure 8 - Tag Programmer Status 

5.3. Problems Connecting with the Programmer 
If the programmer is not found, check the following: 

• Make sure there is a good cable connection between the programmer and the computer 
• Make sure the cable is plugged into one of the communication ports (9 or 25 pin connector 

on the back of the computer) 
• Make sure the null modem is attached to one end of the cable 
• Make sure the programmer is powered on 

 

If the programmer is still not found, try another 9 or 25 pin connector on the back of your 
computer. 

If the programmer continues to not be found, check the display in Figure 8 to see if there are any 
active ports.  If no ports are active check the computer manual on how to activate a communication 
port. 

If you continue to have problems, contact us by telephone at 888 872-4612.  When you call, please 
be at your computer with the screen shown in Figure 8 displayed. 

5.4. Communication Log Menu Item 
Clicking on the Communication Log menu item will cause the display in Figure 9 to appear.  This 
display shows, in real time, communications between the tag programmer (and/or portable reader) 
and the AEI Tag Programming Software.  Each record contains: 

• The date and time the message was sent or received 
• The communication port (C(1) represents communication port 1) 
• The device with which it was communicating (programmer or reader) 
• Whether it was transmitting (T) or receiving (R) the message 
• The message transmitted or received 
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This display is primarily used for diagnostic purposes.  It can be displayed while programming and 
reading tags. 

This display will also appear if the Monitor button is clicked in the status bar. 

 
Figure 9 - Communications Monitoring Display 

5.5. Checking Programmer Status 
The AEI Tag Programming Software will constantly check the status of the tag programmer.  If the 
tag programmer is currently connected, the AEI Tag Programming Software will check every 30 
seconds to see if the tag programmer is still connected. 

If the tag programmer is currently not connected, the program will check every second to see if the 
tag programmer is re-connected.  It will only check the communication port the tag programmer 
was last connected to.  If you want to search all the ports for the tag programmer, use the Search 
For Programmer menu item (see Paragraph 5.2).  

6. TAG PROGRAMMING, READING & CERTIFICATION FUNCTIONS 
The following describes the various tag programming, reading and certification functions. 

6.1. Tag Data Display 
The tag data area of the main tag programming display has four main areas (see Figure 10).  The 
following describes these areas. 
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6.1.1. Tag Fields Area 
The left hand side of the display shows the fields associated with the tag format currently displayed.  
This is the area where information to be programmed into a tag is entered.  It is also the area 
where data is displayed when a tag is read by the tag programmer. 

The fields displayed below the tag format selection box will vary depending on the tag format 
currently selected.  Tag formats can be changed by clicking on the inverted triangle on the right side 
of the selection box and choosing a new format from those listed. 

There are a number of tag formats included with the AEI Tag Programming Software.  The AEI Tag 
Programming Software also allows a new format to be entered.  See Paragraph 9 for more 
information. 

 

 
Figure 10 - Tag Programming Area 

6.1.2. Tag Commands Area 
To the right of the tag data area is a group of tag command buttons.  The buttons in the left column 
are used primarily to command the AEI Tag Programming Software to program, read and certify 
tags.  The right column of buttons is used to quickly change the vehicle number when tags are done 
in a numbered sequence. 
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All buttons in this area also have an F number.  This is a function key number associated with the 
command.  Each of these commands can be entered by either clicking on the appropriate button 
with the mouse or pressing the appropriate function key on the keyboard. 

6.1.3. Tag Programming History Area 
Below the tag data area and the tag commands area is the programming history area.  This is a list 
box that shows up to the last 1,000 tags programmed.  Each record represent one programmed 
tag and contains the following fields separated by commas: 

• Date and time the tag was programmed 
• The tag format of the programmed tag 
• The contents of the data fields associated with the tag format 
• The Association of American Railroads’ defined data format code (should always be 51) 
• The Association of American Railroads’ defined equipment group code 
• The tag type code 
• The UMLER and RF check status 

6.1.4. Raw Tag Data Area 
Below the tag programming history list box is the raw tag data area.  This area shows the raw bit 
data that was programmed into or read from the last tag programmed or read. 

Tags contain 120 bits of data.  This data is represented in two forms, 20 6-bit ASCII characters and 
30 4-bit hexadecimal characters.  The translation table for converting the 6-bit ASCII characters 
into binary can be found in the Association of American Railroad’s AEI Standard S-918, which can 
be downloaded from our web page at www.aeitag.com. 

6.2. Programming a Tag (Railcar) 
To program a tag for a rail car, select Railcar in the Tag Format selection box.  The railcar format 
fields will appear (see Figure 11). 

 

 
Figure 11 - Programming a Railcar Tag 



AEI Tag Programming Software 

 Page 13  
23 January, 2002 

The Equipment Initial field normally consists of two to four alpha characters.  Leading spaces or 
blanks are not allowed.  Spaces and blanks between other characters are not allowed.  The field is 
not case sensitive (“A” and “a” are equivalent).  If only two characters are entered, the system will 
automatically insert spaces for the last two characters of this four-character field.  When the fourth 
character is entered the system will automatically tab down to the next field. 

The down arrow key or tab key can also be used to move down to the next field. 

The Car Number field normally consists of one to six digits.  If less than six digits are entered, the 
program will pad the field with leading zeroes.  When the sixth character is entered the system will 
automatically tab down to the next field. 

The down arrow key or tab key can also be used to move down to the next field.  The up arrow will 
move control up one field to the Equipment Initial field. 

The Side Code field is a selection box that indicates the side of the vehicle on which the tag will be 
placed, and either Left or Right can be selected in this box.  The left arrow and the right arrow keys 
toggle this field between left and right. 

Data in the Length field can be entered in either feet and inches or decimeters, depending on the 
option setting (see Paragraph 4.2.5).  If entered in feet and inches, the format is the number of feet, 
a dash and then the number of inches (ft-in or 60-5 for 60 feet 5 inches).  A length entered in feet 
and inches is immediately converted to decimeters and displayed, in decimeters, to the right of the 
field.  In the same way, lengths entered in decimeters are displayed to the right of the field in feet 
and inches. 

The Number of Axles, Bearing Type Code, and Platform Identifier are all numeric fields and operate 
in the same fashion as the other fields. 

Once all data is entered, click the Program Tag button or press the F1 key. 

If the tag programmer is not connected, an error message will be generated.  If it is connected, the 
program will check all the fields to see if they are within the allowable ranges.  Fields that are not 
within the allowable ranges will cause error messages to be displayed.  In Figure 12 the number of 
axles entered is greater than the allowable range of 1 to 32. 

 

 
Figure 12 - Number of Axles Error 
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After the fields are checked for allowable ranges, the fields are checked against the UMLER 
database if this option is selected (see Paragraph 4.2.2).  If the rail vehicle is found in UMLER and 
there are disagreements on some of the fields, a warning message will be issued (see Figure 13). 

In Figure 13 the length field disagrees with UMLER.  The UMLER value is shown in red to the right of 
the field. 

 
Figure 13 - UMLER Disagreement 

The value in the Length field can be changed to match UMLER, or the warning can be ignored.  If 
ignored, a message will be printed on the tag label that there was a disagreement with UMLER.  If 
UMLER is not checked because the UMLER check option is not selected or the vehicle is not found 
in UMLER, then an “UMLER Not Checked” message will be printed on the tag label. 

Once all checks on the data are made, the AEI Tag Programming Software will send a command to 
the tag programmer to program the tag.  The tag programmer will start beeping, alerting the 
operator to insert a tag in the programming slot and push down on the tag so the programming 
head on the programmer makes contact with the electronics in the programming port of the tag.  If 
the programming is successful, the tag programmer will respond to the AEI Tag Programming 
Software that is has programmed the tag and verified the data in the tag is correct.  If the tag 
programmer sends an error or fails to respond, the AEI Tag Programming Software will warn the 
operator and provide the opportunity to try to program the tag again. 

If the tag programming is successfully and the Automatic RF Check option is not selected (see 
Paragraph 4.2.1), a tag label will be printed (see Figure 14).  This label will show the values of all of 
the fields programmed into the tag and indicate the tag was not RF checked.  This completes the 
tag programming process. 
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Figure 14 - RF Not Checked Tag Label 

If the Automatic RF Check option is selected, prior to the printing of the label, a message will appear 
asking the operator to read the tag with the portable reader.  The portable reader must be 
connected to the computer running the AEI Tag Programming Software through one of the 
computer’s communication (serial) ports.  See Paragraph 7.1 for information on connecting the 
portable reader to the computer’s communication port. 

To read a tag: 

• Turn on the portable reader 
• After it initializes Press 1 (1= Read Tags) 
• Press 1 (1 = Point And Read) 
• Point the reader at the tag and press Read (‘Read Tag’ Now) 

If the portable reader reads the tag and the data is the same as the data programmed into the tag, 
the tag label will indicate the tag was checked by an RF reader (RF Ok see Figure 15). 

 
Figure 15 - RF Ok Tag Label 

If the portable reader data disagrees with the programmed data, a warning message will appear 
and an option will be provided to read the tag again with the portable reader. 

If the Automatic RF Check option is selected, the RF check can, at any time, be overridden by clicking 
on cancel when prompted by the computer to read the tag.  If the tag reading operation is 
cancelled, the user will have the option to print the tag label, which will indicate that the tag was not 
RF checked. 

6.3. Reading a Tag 
The process of reading a tag with the tag programmer is very straightforward.  To read a tag click 
the Read Tag button or press the F2 Key. 

The AEI Tag Programming Software will send a read command to the tag programmer.  The 
operator will be prompted to insert the tag in the reader. If the tag is successfully read, the tag 
programmer will send the data to the AEI Tag Programming Software. The software will determine 
the data’s tag format, update the tag field area with the appropriate fields for the format and then 
insert the data into the fields. 

If an error reading a tag occurs, a warning message will be generated. 
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6.4. Certifying a Tag 
The process of certifying a tag is very similar to programming a tag with two exceptions.  The AEI 
Tag programming Software will automatically generate the data to be programmed into the tag, 
and the tag must be checked by a portable RF reader. 

When the Certify button or the F9 key is pressed, the AEI Tag Programming Software will: 

• Switch the current tag format to the Railcar format 
• Enter the Equipment Initials that were specified in the Certification Vehicle Initial setup 

function (see Paragraph 4.1.2). 
• Generate a car number.  The first three digits of the number will be the current Julian 

date and the last three numbers the accumulated number of tags certified by the system 
• Randomly select a side indicator code 
• Randomly enter a length within the allowable parameters 
• Randomly enter the number of axles within the allowable parameters 
• Enter 1 for bearing code 
• Enter 0 for platform code 
• Send a command to the tag programmer to program the tag 

After the tag programmer successfully programs and checks the tag and the portable RF reader 
verifies the data in the tag, a special certification tag label will be printed (see Figure 16).  This label 
will not be printed unless the tag is RF checked with a portable reader.  There are no overrides for 
the RF reader check for this function. 

 
Figure 16 - Certified For Reuse Tag Label 

This certification function only tests whether the tag can be successfully programmed and RF 
checked.  It should be noted that range and leak tests should also be conducted on tags being 
certified for re-use.  

6.5. Quick Car Number Increment Commands 
There are many occasions when a sequence of the same type cars will be tagged.  The AEI Tag 
Programming Software has several buttons to quickly change the entered tag data for the next car. 



AEI Tag Programming Software 

 Page 17  
23 January, 2002 

The Next Car button, when clicked, or the F8 key, when pressed, increments the car number or 
changes the side code indicator for the next tag.  The equipment initials, length and other fields 
remain the same.  The system assumes the left of a pair of tags will always be programmed first.  
The data for the left tag in a pair should first be entered and the tag programmed.  Then, when the 
Next Tag button is clicked, the program will change the side indicator to the right.  It will not 
increment the car number.  The next time the Next Tag button is clicked, the car number will be 
incremented and the side indicator toggled to the left.  The following is an example of the sequence 
of tags that would be programmed by clicking the Next Tag button: 

SCCX 103201 Left 
SCCX 103201 Right 
SCCX 103202 Left 
SCCX 103202 Right 

The Previous Tag button or F5 key does the opposite of the Next Tag button.  The following is an 
example of the sequence of tags that would be programmed by clicking the Previous Tag button: 

SCCX 103203 Left 
SCCX 103202 Right 
SCCX 103202 Left 
SCCX 103201 Right 

The Add 10 (F7), Add 100 (F6), Subtract 10 (F4) and Subtract 100 (F3) buttons and keys are used 
to change the car number by adding or subtracting the designated number from the car number.  
These commands will not toggle the Side Indicator code as does the Next Tag and Previous Tag 
commands. 

6.6. UMLER Lookup 
The UMLER database that accompanies AEI Tag Programming Software can be searched for a 
particular vehicle.   The equipment initials and car number for the vehicle must be entered in the 
appropriate fields before a lookup can occur.  The search is then initiated by clicking the UMLER 
Lookup button or pressing the F12 key.  If the vehicle is found, the program will insert the UMLER 
data into the appropriate programming fields.   

The UMLER database in the AEI Tag Programming Software contains some additional fields for 
each vehicle such as vehicle type, tare weight and capacity weight.  These can be viewed by 
selecting the Display UMLER Record menu item under the View menu.  This will cause the dialog in 
Figure 17 to appear. 

If you place the mouse pointer on any empty area of the screen and click the right mouse, this menu 
item will also appear in a pop-up menu. 

The Type field in Figure 17 contains the vehicle type code as defined in RAILINC’s UMLER Data 
Specification manual.  
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Figure 17 - UMLER Data 

6.7. Tag Programming Counters 
There are two counters at the bottom of the screen (see Figure 18).  The first counter shows the 
number of tags programmed today.  The second counter accumulates the number of tags 
programmed until it is reset by the Clear Tag Counter button. 

 
Figure 18 - Tag Programming Counters 

6.8. Tag Labels 

6.8.1. Tag Programming Label  
The following describes the fields in the tag programming label (see Figure 19): 

 
Figure 19 - Tag programming Label 

• First line (large bold characters) 
o Equipment Initial 
o Vehicle Number 
o Side Indicator 

• Second Line 
o Date and time the tag was programmed 
o Tag format type 
o Equipment group code in parenthesis (5 = locomotive, 19 = railcar) 
o Data fields (length, number of axles, bearing type code, and platform code, if railcar) 
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• Third Line 
o UMLER check status 
o RF check status 
o Last eight digits of AEI Tag Programming Software’s serial number, which is unique to 

the user 

• Fourth Line 
o Identification of the organization or individual who programmed the tag (as entered in the 

Programmed By setup command, see Paragraph 4.1.3)  

6.8.2. Tag Certification Label  
The following describes the fields in the tag certification label (see Figure 20): 

 
Figure 20 - Tag Certification Label 

 

• First Line (large bold characters) 
o Certified For Reuse message 

• Second Line (data programmed into tag for test, always railcar format) 
o Date and time the tag was certified 
o Equipment initials (as entered in Certification Vehicle Initial setup command, see 4.1.2) 
o Vehicle number 
o Side indicator (L = left, R = right) 
o Length 
o Number of axles 
o Bearing type code 
o Platform code 

• Third Line 
o RF check status 
o Last eight digits of AEI Tag Programming Software’s serial number, which is unique to 

the user 

• Fourth Line 
o Identification of the organization or individual who programmed the tag (as entered in the 

Programmed By setup command, see Paragraph 4.1.3)  

 

7. SMARTSCAN PORTABLE READER 
The AEI Tag Programming Software system is designed to interface with the AI2000 SmartScan 
Portable Reader.  This hand-held RF reader is used to check a tag to see if it has been correctly 
programmed and if it can be read by a wayside AEI RF reader. 
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The AI2000 SmartScan Portable Reader must have version 1.6 firmware or later to operate 
correctly with the AEI Tag Programming Software.  If you have an earlier version contact Signal 
Computer Consultants at 888 872-4612, and we can get your portable reader updated. 

The portable reader interfaces to the computer running AEI Tag Programming Software through 
one of the computer’s communication (serial) ports. 

7.1. Connecting the SmartScan Portable Reader to the Computer 
The portable reader comes with a communication cable terminated on one end by a serial 
connector (either 9 pin or 25 pin male connector).  Connect this cable to a communication (serial) 
port on the computer.  The other end of the cable has an RJ-45 connector that fits the combined 
charging/communication port on the portable reader. 

7.2. Portable Reader Tools  
To communicate with the portable reader, the AEI Tag Programming Software must know to which 
communication port the portable reader is connected.  There are two methods to enter this 
information.  The communication port can be manually entered or the AEI Tag Programming 
Software can search all communication ports (1 thru 4 only) for the portable reader.  To access 
either of the methods, click on the RF Reader menu in the menu bar. 

7.2.1. Reader Port Assignment Menu Item 
By clicking on this menu item a dialog will be opened that allows the manual assignment of the 
communication port that connects to the portable reader. 

7.2.2. Search For Reader 
By clicking on this menu item the AEI Tag Programming Software will search all communication 
ports (1 thru 4 only) for the portable reader.  For this operation to be successful, the portable 
reader must be connected to the computer, must be powered on and in Host Initiated mode.  To 
place the portable reader in Host Initiated mode: 

• Turn on the portable reader 
• After the portable reader initializes press 3 (3=Host Transfer) 
• Press 2 (2=Host Initiated) 

After clicking on this menu item a message will appear that the program is searching for the 
portable reader.  This search will take 10 seconds whether the portable reader is found or not.   

If a portable reader is found on one of the communication ports, the system will continue to scan 
the other ports to see if another portable reader is connected. 

If more than one portable reader is connected, the system will ask that all but one of the portable 
readers be disconnected. 

If only one portable reader is found, the program will generate a message that includes information 
on which communication port the portable reader was found.  The program will remember the port 
number. 

If no portable readers are found, the dialog in Figure 21 will appear.  This dialog shows the status of 
each of the four communication ports.  If a communication port is shown as not active, it can either 
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mean that the port does not exist on the computer or it is currently being used by another 
application. 

 

 
Figure 21 - Searching for Portable Reader 

7.2.3. Portable Reader Parameters Menu Item 
Clicking on this menu item will cause the display in Figure 22 to appear, which shows the portable 
reader’s internal parameters. 

 
Figure 22 - Portable Reader Parameters 
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7.2.4. Problems Connecting with the Portable Reader 
If a portable reader is not found, check the following: 

• Make sure there is a good cable connection between the portable reader and the computer 
• Make sure the cable is plugged into one of the communication ports (9 or 25 pin connector 

on the back of the computer) 
• Make sure the portable reader is in the Host Transfer/Host Initiated mode (the portable 

reader is displaying the “Waiting for Host…” message). 
 

If the portable reader is still not found, try another 9 or 25 pin connector on the back of your 
computer. 

If the portable reader continues to not be found, check the display in Figure 21 to see if there are 
any active ports.  If no ports are active check the computer manual on how to activate a 
communication port. 

If you continue to have problems, contact us by telephone at 888 872-4612.  When you call please 
be at your computer with the screen shown in Figure 21 displayed. 

8. UMLER DATABASE 
The Association of American Railroads maintains a rail equipment database called UMLER 
(Universal Machine Language Equipment Register).  AEI Tag Programming Software is designed to 
maintain a subset of the UMLER database.  This subset consists of the following items for all 
vehicles registered in UMLER: 

• Vehicle type 
• Coupler to coupler length 
• Number of axles 
• Bearing code 
• Number of platforms 
• Tare weight 
• Capacity weight 

 
When tags are to be programmed, the AEI Tag Programming Software will automatically compare 
the data entered in the programming fields with the data in UMLER for that vehicle (if Automatic 
UMLER Check option is selected, see Paragraph 4.2.2). 

When the program is initially installed, an UMLER database is pre-installed with the program. 

Because UMLER is constantly being updated, Signal Computer Consultants plans to create a new 
UMLER CD periodically and distribute it to customers on a subscription basis.  To obtain more 
information about this service, contact Signal Computer Consultants. 

8.1. Loading the UMLER Database from a CD 
To load the UMLER data, insert the UMLER Database CD into the CD drive and select the Load 
UMLER CD Data item from the File menu.  Opening the file “Umler.txt” on the CD expands and 
transfers the database to the hard drive. 
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8.2. Searching for Vehicle UMLER Data 
The system allows users to search the internal UMLER database subset for a particular vehicle.  To 
find the UMLER data, select the Find UMLER Data item under the Tools menu, enter the vehicle’s 
initials and number in the dialog, and click the Find button.  If the vehicle record is found, the data will 
be displayed as shown in Figure 23. 

 
Figure 23 - Find UMLER Data 

RAILINC’s UMLER Data Specification Manual provides detailed information on these data items.  
This manual can be obtained from the Association of American Railroads at www.aar.org. 

9. TAG FORMATS MAINTENANCE 
The AEI Tag Programming Software allows the structure of pre-loaded tag formats to be viewed or 
new formats created.  The program will not allow pre-loaded tag formats to be changed, but they 
can be copied to make new formats. 

9.1. Viewing Tag Format Structures 
Tag format structures can be viewed by selecting the Tag Format menu item under the Tools menu.  
The dialog in Figure 24 will appear.  By selecting an existing tag format and clicking the Ok button, 
the dialog in Figure 25 will appear.  The dialog is read only for the tag formats that are pre-loaded 
with AEI Tag Programming Software, but fields may be altered for other tag formats. 
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Figure 24 - Tag Format Request 

 
Figure 25 - Tag Format Structure 

Information about different tag formats can be found in the Associations of American Railroads’ 
Standard for Automatic Equipment Identification S-918.  This standard can be downloaded from our 
web page by going to the Web Pages menu and selecting the Download AAR Standard S-918 menu 
item. 

The Amtech tags can be programmed with up to 120 bits of data.  There are also 8 bits of 
checksum and frame marker data.  Therefore, the total number of bits stored in an Amtech tag is 
128. 
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The checksum and frame marker bits are at bits 60 thru 63 and 124 thru 127.  These bits cannot 
be used to store user data. 

The following describes the fields in the dialog in Figure 25: 

• Format name – this is the internal name assigned by the user to the format.  Duplicate 
format names are not allowed. 

• Equipment Group Code (as defined in AAR Standard S-918) – this code tells the reader 
system the tag format that should be used to decode the data.  Equipment Group Code 
19 is assigned to the rail car format.  Equipment Group Code 5 is assigned to the 
locomotive format.  A complete list of equipment group codes can be found in the AAR 
Standard S-918. 

• Data Format Code (as defined in AAR Standard S-918) – the AAR Standard S-918 code 
associated with the data format. 

• Tag Type Code (as defined in AAR Standard S-918) – the AAR Standard S-918 code 
associated with the tag type. 

• Default Tag – the tag model number usually associated with this tag format. 

• Field names – the name assigned by the user to the field.  This name will appear in the 
tag data area of the main tag programming display (see Figure 10). 

Duplicate names are allowed in adjacent fields.  This is only used when a field is broken 
into several different areas in the tag.  In Figure 25 the name Length is used twice.  The 
length data is found in bits 94 thru 96 and 47 thru 55 in the railcar tag.  The most 
significant data is in bits 94 thru 96, which must be the first field that uses the name 
Length.  The AEI Tag Programming Software will combine these two fields to encode the 
length data into the tag. 

• Starting Bit – the bit in the tag where the field starts.  The first bit in the tag is 
designated as 0.  The start bit number can be from 0 to 59 and 64 to 123. Bits 60 thru 
63 and 124 thru 127 are reserved for checksum and frame marker information and 
cannot be used to hold programmed data. 

• Length – the length of the field in bits.  The length cannot be longer that 64 bits. 

• Type - defines how the data field is encoded in the tag.  For the Equipment Initial field in 
Figure 25, the type is defined as binary (alpha base 27).  The algorithms for the different 
types can be found in the AAR Standard S-918. 

• Minimum Value – the lowest value allowed in the field.  In alpha fields A is considered to 
be the next to the lowest value character (space is the lowest) and Z is the highest. 

• Maximum Value – the highest value allowed in the field. 

• Default Value – the value that will appear in the field prior to entering a value. 

9.2. Adding and Modifying Tag Formats 
New tag formats can be entered into the program.  These new formats can also be modified and 
deleted.  The tag formats that are pre-loaded with AEI Tag Programming Software can neither be 
modified nor deleted.  
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There are two methods for creating a new tag format.  In the dialog in Figure 24 the user can select 
<<New>>, which causes the dialog in Figure 25 to appear with all fields bank. 

The second method is to request an existing tag format and click the Copy button in the dialog in 
Figure 25.  This causes all existing field values to remain the same except the tag format name, 
which changes to New.  An OK button will appear between the Copy and Cancel buttons in the 
dialog.   

Any field, including the tag format name, can now be changed.  Once all the changes are made, the 
format will be checked and saved when the OK button is clicked.  The AEI Tag Programming 
Software will make a number of checks to insure there are no obvious errors (wrong type of data in 
the field, the field is too large, fields overlap, etc.), but proper operation of a new tag format is 
ultimately the responsibility of the user who creates the new tag format. 

The user should check tags programmed with user generated tag formats independently of the AEI 
Tag Programming Software.  This should be done prior to using the format for programming 
production tags. 

Once a new format is saved, the format name will appear in the Tag Format field (see Figure 10), 
when the selection box is expanded, and in the Format Request dialog shown in Figure 24. 

9.3. Deleting Tag Formats 
Only tag formats created by the user can be deleted from the program.  Pre-loaded tag formats 
cannot be deleted. 

To delete a tag format, select the format from the dialog shown in Figure 24.  This will cause the 
dialog in Figure 25 to be displayed with the format’s data.  A Delete button will appear beneath the 
Default Tag field.  Click the Delete button to delete the format. 

10. PROGRAMMED TAG LOG FILE 

10.1. Opening and Printing the Tag Log File 
 
The AEI Tag Programming Software maintains a log of all tags programmed if the Log File option is 
on (see Paragraph 4.2.4).  The name of the log file is, by default, “tag log.txt”.  This name can be 
changed by using the Assign Log File Name setup function (see Paragraph 4.1.1). 

The log file can be opened and displayed by clicking the Open Log File menu item under the View 
menu.  This will cause the file to be opened in Notepad or WordPad.  The file can be printed or 
modified by these programs. 

Each record in this file represents one programmed tag and contains the following fields, separated 
by commas, that were programmed into the tag: 

• Date and time the tag was programmed 
• The tag format used to program the tag 
• All the tag fields associated with the tag format 
• The Association of American Railroads’ defined data format code (should always be 51) 
• The Association of American Railroads’ defined equipment group code 
• The tag type code 
• The UMLER and RF check status 
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• The raw tag data displayed as 30 4-bit hexadecimal characters 

The AEI Tag Programming Software periodically checks the size of the log file.  If the file size 
increases to over 1 MB, the program will reduce the size of the file to 1 MB by deleting the oldest 
tag programming records. 

10.2. Programmed Tag Log Window 
A secondary window displaying up to the last 1,000 programmed tag records can be displayed by 
selecting the Display the Programmed Tag Log menu item under the View menu.  This will cause the 
window in Figure 26 to appear. 

If you place the mouse pointer on any empty area of the screen and click the right mouse, this menu 
item will also appear in a pop-up menu. 

The columns can be resized by placing the mouse pointer on the vertical lines between the column 
headers and dragging them to the left or right. 

Clicking on the Save Column Size button will save the column sizes. 

The data in the Data Fields column is in the same format as the data in the log file (see Paragraph 
10.1) except the raw tag data is not included. 

 

 
Figure 26 - Tag Log Window 

11. COMMUNICATIONS LOG FILE 
The AEI Tag Programming Software maintains a log file of all communications between the 
program, the AP4100 Programmer, and the AI2000 SmartScan Portable Reader.  This log file is 
named “communication log.txt” and is used for diagnostic purposes.  This file is a text comma 
delimited file that can be viewed by any standard word processing program. 
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The AEI Tag Programming Software periodically checks the size of the communications log file.  If 
the file size increases to over 1 MB, the program will reduce the size of the file to 1 MB by deleting 
the oldest communication records. 

12. TECHNICAL SUPPORT AND UPDATES 
Periodically Signal Computer Consultants issues maintenance releases and new versions of this 
program.  Maintenance releases are free and correct problems found with the program and/or 
provide minor enhancements to the program.  Before contacting us with problems we suggest that 
you check our web page at www.aeitag.com to ensure that you have the latest maintenance release 
of the program.  You can also go to our web page by clicking the appropriate web page item under 
the program’s Web Pages menu at the top of the screen. 

For technical support or more information contact Signal Computer Consultants at: 

 

Signal Computer Consultants 
P.O. Box 18445 
Pittsburgh, PA  15236 
 
Tel. 888 872-4612 (toll free US and Canada only) or 412 655-1884 
Fax. 412 655-1893 
E-mail signal@signalcc.com 
Web Page www.aeitag.com 
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